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A PROJECT WITHIN MICROSOFT PROJECT 2007 

Emil COSMA� 

Abstract 
The main purpose of this article is to emphasize the innumerable advantages of the Microsoft Project 2007 
projecting environment that a project manager could benefit of. More exactly, 
 Project Management stands for a function that is recognized within the majority of domains. A project is 
defined as “a temporary effort made for creating a product or a unique service”. A projects’ administrative 
programme within an informational system (such as Microsoft Project, Primavera Planner) represents a 
“database that is in concordance with time”. It should help proceeding the required operations and, at the 
same time, to look and behave the same way other frequently utilized productive programmes. It keeps 
accounts of all information regarding the job requests, period and the project’s needed resources and 
visualizes the project’s plan in standard, well-defined formats, organizes the activities and resources 
consistently and efficiently,shares information regarding the project with all persons involved in an intranet 
or Internet network, and communicates efficiently with the resources and other involved persons, permitting 
at the same time the project manager to take the final control/decision as his/her responsibility.
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Introduction 
 
A project is temporary. A project’s length of time varies from one week, for example, to 

even a few years, yet every project has a deadline. When starting to work at the project, there is the 
possibility of being unaware of its deadline, yet one knows that it occurs in the future. Even if they 
have a lot in common, the projects are not similar to the progressing operations. The name 
suggests the fact that the progressing operations continue indefinitely; one can not establish a 
deadline. For instance, one could mention the majority of the activities within the accounting and 
human resources departments. The projects are different from the processing operations because of 
an already established deadline.  

� A project requires effort. Just like human and equipments, the resources also work. 
The effort is undertaken by a team or an organization, so that the projects appear as intentional, 
scheduled events.  

� Every single product creates an unique service or product. The result or the 
project’s final product represents the reason for which the project has been undertaken. A gas 
refinery doesn’t produce a unique product. On the other hand, the commercial planes do stand for 
unique products.  

Microsoft Project (or MSP) is a project management software program developed and sold 
by Microsoft which is designed to assist project managers in developing plans, assigning resources 
to tasks, tracking progress, managing budgets and analyzing workloads. The first version, 
Microsoft Project for Windows v1.0, started in 1987 on contract to a small external company. In 
1988 the company was acquired by Microsoft, bringing the development project in-house where it 
was finished and released in 1990 as part of the company's applications offerings for Microsoft 
Windows 3.0. Microsoft Project was the company's third Windows-based application, and within a 
couple of years after its introduction WinProj was the dominant PC-based project management 
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software. Further versions were released in 1992 (v3), 1993 (v4), 1995, 1998, 2000, 2002, 2003 
and 2007. There was no Version 2 on either platform; the original design spec was augmented with 
the addition of macro capabilities and the extra work required to support a macro language pushed 
the development schedule out to early 1992 (Version 3). The application creates critical path 
schedules, although critical chain and event chain methodology third-party add-ons are available. 
Schedules can be resource leveled, and chains are visualized in a Gantt chart. Additionally, Project 
can recognize different classes of users. These different classes of users can have differing access 
levels to projects, views, and other data. Custom objects such as calendars, views, tables, filters 
and fields are stored in an enterprise global which is shared by all users. Microsoft Project and 
Project Server are the cornerstones of the Microsoft Office Enterprise Project Management (EPM) 
product. 

 
Literature review  
Schedules, budgets, communications, resources-projects big and small include them all, and 

Microsoft Project 2007 can help you control these variables - not be controlled by them. But 
Project is complex software, and learning it is, a project in itself. Over the years and versions, 
Project has collected improvements. Yet one feature has gottenworse: Project documentations. To 
use Project successfully, you need to understand something about project management, but that is 
an exercise Microsoft leaves to its customers. There are many Internet resources, books and papers 
which serve as manuals that should have accompanied Project 2007, for example: Bonnie, Biafore, 
2007, Microsoft Project 2007: The Missing Manual, Pogue-Press: O’ Reilly; Carl, Chatfield, and 
Timothy, Johnson,2007,  Microsoft Office Project 2007 Step by Step, Microsoft Press;  Dave, 
Gochberg, and Rob, Stewart , 2008, Microsoft Office Project Server 2007: The Complete 
Reference, McGraw-Hill Osborne;  Dale, A. Howard, and Gary, L. Chefetz, 2007, Ultimate 
Learning Guide to Microsoft Office Project 2007,  Soho Corp;   Elaine, Marmel, 2007, Microsoft 
Project 2007 Bible, John Wiley & Sons. The purpose of this article is to present in detail an 
example of a project, using Microsoft Project 2007 called Dream House. 

  
Theoretical Background 
  
�The project’s “triangular” method  
One may visualize the projects’ work in 

different ways, but the most favourite one is the 
so-called project triangle, having numerous 
options, however, the main idea is that every 
project includes a certain time restriction grade, a 
definite type of budget and requires a certain work 
tasks quantity (it has a defined objective). 

 
Time. For many projects that 

create a product or a result when relating to an event, time represents the most 
important restriction that should be administrated. There is the possibility that the 

project’s budget or the work’s objective may be unknown, yet it is likely that one knows the 
project’s time limit.  

 
Cost. The costs represent all necessary resources for the project’s realization.  The 

cost includes people and equipments that work effectively, needed materials and all 
events and elements that require money or a person’s involvement within a project. For almost all 
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projects, the cost stands finally for a restriction; there is also the possibility of projects exceeding 
the budget, without being necessary to make eventual corrective actions.   

 
Objective. One should take into consideration two aspects of the objective: 
� Project’s objective. Every single project results in a unique 

product: an element or a palpable service. Usually, customers expect a series of 
characteristics and functions regarding the products they consider to buy. 

� Product’s objective describes sometimes in details the qualities, the 
characteristics and the desired functions regarding the product. The documents that offer such 
information are sometimes called products specifications. The services and the events have usually 
a series of foreseen characteristics. On the other hand, the project’s objective describes the 
required operations of a product or service’s delivery, having the product’s desired specifications 
and objective. Even though the project’s objective focuses on the client or the product’s consumer, 
it is preoccupied mainly with the persons who will finalize the project. The project’s objective is 
usually measured by activities and phases.  

The product’s objective and the project’s objective are very similar. The project manager 
who administrates the project’s objective should also realize that he/she should also know well the 
product’s objective or how to communicate with people who are acknowledged with this type of 
data. 

� Restrictions administration in regards to projects 
The most sensible aspect which concerns the project’s management is that of maintaining 

equilibrium between the restrictions of projects’ objective, time and cost. The project triangle 
shows the process of realizing equilibrium between restrictions because all three triangle sides are 
connected, and one triangle side’s alteration could affect at least one of the two remaining sides: 

• If the project’s plan duration (time�) is reduced, it might need the budget (cost�) 
increase, due to the fact that one needs to employ many resources that do the same work within a 
short time period. If one doesn’t achieve to increase the budget, then it may need to reduce the 
objective (objective�) because the available resources are not able to execute all operations that 
are scheduled for a short time period. 

• If the project’s budget (cost�) decreases, one may possibly need a little bit more time 
(time�) because it’s impossible to pay so much resources with the same efficiency. If the time 
period doesn’t increase, it is needed to reduce the project’s objective, because fewer resources are 
not able to perform all scheduled operations in the remaining available time period. If a project’s 
budget should be reduced, one should analyze the material resources classes for which the 
budgetary resources were established. An inferior class material is not necessarily a bad quality 
material. As long as the material class corresponds with the desired utilization, it could have good 
quality. One should also analyze the costs of human resources and equipment that were scheduled 
for utilization. A project manager should take into consideration (or better discuss with a decision 
factor) the advantages and risks of costs reduction.  

• If the project’s objective� increases, one may need more time� or many resources 
(cost�) for the additional operation’s performance. If the project’s objective extends itself after the 
project’s starting, then it is called expanded objective.  The objective’s modification of a project 
that was executed partially is not necessarily a negative fact; for example, there could be the 
possibility that the project’s beneficiary was changed and a different product should be delivered 
to the new customer. A change in the project’s objective has a negative influence only if the 
project manager doesn’t execute the planning and the acknowledgment for the new requests – this 
situation occurs when the other restrictions (cost, time) are not analyzed correspondingly or, if it’s 
the case, corrected.  
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Short Presentation of the Microsoft Project Display Environment 
 
Introduction 
Microsoft Projects is part of the Microsoft Office program ‘family’ for desktop computers, 

that’s why many elements included in Microsoft Project are similar to those of Word, Excel and 
Access. For instance, the organization of the general menus bar and the instruments bar are very 
alike. Microsoft Project offers access to the same assistance instruments (Help), Office Assistant 
and ToolTips. On the other hand, many operations performed by Microsoft Project are different 
from those within other Office programs. Most of the elements displayed in the Microsoft Project 
program accept indications or ToolTips labels.  In order to observe some of the available 
ToolTips labels, one should put the mouse cursor on the bars and data within Gantt Chart or on the 
buttons included in the instruments bars.  

The creation of a project file 
Project is mainly based on the time parameter. Almost all projects have a start date and 

finish to a subsequent date. Sometimes it is known only the intended start date for the project, the 
planned finish date, or maybe both dates. Yet, when working within Project, one specifies only a 
date, and not both: whether the project’s start date or the finish date. After introducing the 
project’s start date or finish date and the activities’ durations, Project automatically calculates the 
other date. Project represents not only a static storage with information regarding the project, but 
also an active schedule instrument.  

Even though one knows already the project’s deadline, most projects should be scheduled 
beginning with a start date. The schedule based on the start date determines the actions’ 
performance as soon as possible and offers the best flexibility in planning.  

A Project file can be created (New), but one may also create a file based on a pattern. One 
may save any Project file as a pattern. When doing so, one could choose information that could be 
excluded from the pattern, such as planned or real programmes or information about the costs. 

The work interface within Project is called view. Project contains tens of views, yet 
normally, at a given time one should work only with one (and sometimes with two). The views are 
used for introduction, editing, analyzing and displaying the information regarding the project. The 
already established view is the Gantt Chart View. 

There are many commuting methods between views: 
• One should select a view out of the most frequent used, which are displayed in the 

Views bar that is situated in the left margin of the Project window.  
• One selects a view from the same view set within the View menu. 
• One could visualize all available views by selecting the More Views… command from 

the View menu. 
Every view focuses on the details in regard to task, resource or assignment. In many 

views, these details are organizes into tables. The pre-established table from the Gantt Chart View 
is know as the Entry table and contains information about tasks. A table stands for a data grid 
which is similar to a calculation sheet that is organized into rows and columns. Every row contains 
information about a single task or resource. Every column describes a single value of that 
particular task or resource.  

The Resource Sheet View is concerned with the resources’ details. The pre-established 
table for this view is an Entry type one. One may also commute to another table in order to see 
other details about resources. 

Using the Task Usage View one may visualize tasks within the left numbered rows, and 
under these, the resources assigned to every task. There is a timescale grid that contains daily work 



496  Lex ET Scientia. IT Series�

LESIJ NR. XVI, VOL. 1/2009 

values for every allocation. Just like Gantt Chart and other views within Project, the Task Usage 
view is divided in two zones. Every single zone has its own horizontal scroll bar. 

In order to change the table which appears in a view, one needs to position the mouse 
cursor on the Table option within the View menu and select the table. By commuting the tables, 
the information displayed in the view modifies, but the effective information does not.  

The methods used for controlling data displayed in Project are: 
� One should select the view that organizes and presents in big raws information regarding 

tasks, resources or assigments.  
� Within the selected view, one chooses a task or a resource (not all views accept tables). 
� One may filter, sort or organize the data, using another way which fits the purpose. 
Besides using this incorporated tables and views, one may also personalize or create his/her 

own. 
Within the Project window, one may display simultaneously two views. For instance, one 

could display the Gantt Chart view in the upper panel and the Task Usage view in the window’s 
below panel. If this arrangement is used, the task that is selected in the upper panel changes what 
one may see in the below panel. In a similar way, scrolling the temporary grid in the below panel 
modifies the temporary grid from the upper panel of the Gannt Chart view. 

The Resource Allocation and Task Entry views are both pre-defined views for divided 
screens and other combinations. One may also display two chosen views by using the Split option 
from the Window menu.  After the Project window gets divided in two panels, one may choose the 
desired view in order to display it in that particular location. If one wishes to get back to the one-
view mode, he/she should select the Remove Split option from the Window menu.  

 
Case study: dwelling house construction –”Dream House” 

 
Tasks introduction 
Tasks stand for fundamental constitutive blocks of a project- they represent the actions that 

should be made for accomplishing the project’s objectives. The tasks describe the project’s work 
in terms of sequence, duration and resources request.  

Within Project, one of the locations where views are introduced is the Gantt View. In the 
pre-established Gantt View, the bar diagram appears in the right side, and a table is displayed in 
the view’s left side (the Entry table appears in a pre-established way, but one could also display 
any other table). Even though the Entry table may look similar to a grid from a Microsoft Excel 
spreadsheet, it behaves more like a database table. Every row within an Excel table describes a 
single activity, to which a task identifier (task ID) is attached.  

Task identifiers appear in the task row’s left side and the column titles, such as Task Name 
and Duration, are field patterns. The meeting point between a raw (or task) and a column is called 
cell or field. Actually, the internal architecture of a Project file has much more in common with 
that of a database file such as Microsoft Access, than to the architecture of a spreadsheet 
application such as Excel.  

Within the Entry table, on the Task Name column, one may introduce the tasks. Projects 
allots a one day period for all new tasks. The question mark shows that there is an estimated 
duration.  
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Task duration stands for the estimated time quantity till the task finalization. The total 

project’s duration is determined by means of calculating the difference between the start date and 
the last date of finishing the tasks that compose it. The project’s duration is also influenced by 
other factors, such as the relationships between the tasks. Due to the fact that Project makes a 
distinction between the working time and the off time, task duration is not necessarily connected 
with the elapsed time. Yet, there is the possibility to plan tasks to run both during working periods 
and off periods. In order to do so, one needs to assign an elapsed duration to a task. The PERT 
analysis (Program Evaluation and Review Technique) may be considered a useful tool for 
estimating the tasks duration. The Project’s Office Assistant modulus (“Estimate task durations by 
using PERT analysis”) offers more information in regard to this subject. 

When using the Project application, one may use duration abbreviations: 
 

Abbreviation Display Meaning 
m min Minute 
h hr Hour 
d day Day 
w wk Week 
mo mon Month 
em emin Elapsed minute 
eh ehr Elapsed hour 
ed eday Elapsed day 
ew ewk Elapsed week 
emo emon Elapsed month 

 
The pre-established values are necessary: 8 hours/day, 40 hours/week and 20 days/month. 

When creating those tasks, Project allots one day estimated duration for each (the question mark 
within the Duration field shows the fact that duration represents an explicit estimation, even if 
actually, all task durations should have been taken into consideration as estimations until the task’s 
ending).  

One introduces the following data for tasks: 
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The projects assume the tasks’ performance, having a certain order. There is a Start-to-
Finish relationship between two tasks, so that one could define four types of relationships 
between tasks: 

 
FS Finish-to-Start The finishing date of the preceding task determines the starting date of 

the subsequent one 
SS Start-to-Start The starting date of the preceding task determines the starting date of 

the subsequent one 
FF Finish-to-Finish The finishing date of the preceding task determines the finishing date of 

the subsequent one 
SF Start-to-Finish The starting date of the preceding task determines the finishing date of 

the subsequent one 
 
The tasks 1 and 2 are connected through a Finish-to-Start relationship (one should select the 

tasks 1 and 2 on the button and press the  (Link Tasks) button from the Standard Toolbar). 
Project changes the start date of the task 2 in the next working day that follows the task 1’s 
finalization. In order to cancel the relationships between the tasks, one should select those tasks 

among which the relationship must be cancelled and then press the  (Unlink Tasks) button. If 
one cancels a relationship for a single task which is part of a task chain connected with a Finish-to-
Start relationship, Project remakes the relationships between the chain remaining tasks.  
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The 3-8 tasks have the same start date, but the 9, 10, 11 tasks are chained:  
 

 
 

In order to change the scale time in the Gantt Chart view, one should use the  
buttons (Zoom In and Zoom Out).  

 
Project duration 
 
A simple method of finding out the project’s total duration is the examination of the Project 

Information dialogue box, the Statistics button. One could edit the starting date but he/she can not 
edit directly the finish date because this project is adjusted to be planned on a start date basis. One 
may visualize the project’s total duration, based on the duration of tasks and relationships between 
the inserted tasks.  
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Tasks’ organization into phases 
 
Within Project, the phases are represented by summary tasks. A summary task behaves 

different from other activities. One can not directly edit duration, starting date or other scheduled 
values because these are derived from detailed tasks. The summary tasks are useful for those who 
want to obtain information about the project work’s phases.  
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The main project management’s objective: the top-down and the down-top schedule:  

The top-down planning The down-tip planning 
Identifies the important project’s phases and products 
before specifying the necessary tasks for finishing 
these phases. The complex projects may have more 
phase levels.  

Identifies as many low level detailed tasks as 
possible, before organizing them into logical groups 
that are also known as phases or summary tasks.  

It works from general to detailed.  It works from detailed to general.  
The project objectives evolve usually from top to bottom; whereas project’s scheduled 

details tend to have a down-top development. The creation of correct activities and phases for 
more complex projects implies a combination between the top-down schedule and the down-top 
one.  

Summary task and additional tasks’ introduction:  
� Within the Entry table, click on task 1; 
� Within the Insert menu, click on the New Task command; 
� Within the new task that corresponds to the Task Name field, one introduces the Dream 

House text (in fact the project); 
� One should further add other tasks (phases): General conditions, Notifications and 

Approvals, Building Sites work; 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
� One defines the phases. For instance, for the Notifications and Approvals phase, one 

selects the 5-10 tasks and press the  (Indent) button;  
� One links the tasks. For example, for the Building Sites work phase, one selects the 

13-15 tasks and press the  (Link Tasks) button. 
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Resources Configuration 
 

 
 
The resources are represented by people, equipments and needed materials for project’s 

task performance. Project focuses on two resources’ aspects: the availability and the cost. The 
availability determines the moment when a certain resource deals with a certain task and the 
amount of time for working; the costs refer to the amount that is necessary to be paid for that 
particular resource.  

Comparing to the planning tools that focus on the task (agenda), the resources 
administration is effectively the most important advantage of using the Project application.  

Project deals with two types of resources: work and material resources. The work resources 
stand for the persons and equipments that execute the project’s effective work.  

 
The resources are inserted in the Resource Sheet view, on the Resource Name column. One 

needs some explanations regarding the Max. Units field. This represents the maximum capacity of 
a resource performing any task. If the maximum number of units for a resource is mentioned, it 
means that 100% of resource’s time is available for working its allocated tasks. Project gives a 
warning if a resource’s is attributed more tasks than it could execute at a maximum work capacity 
(in other words, it becomes overallocated). Within the Type field, one should select the Work (or 
Material) option for each and every resource.  

Personnel and equipment resources are adjusted in the same way. There are several 
important differences regarding the way in which these two types of resources may be scheduled. 
For instance, the majority of the personnel resources do not have working days that last more than 
12 hours, yet, the equipment resources may work more slowly. Moreover, the personnel resources 
may be more flexible in regard to tasks they can perform, while the equipment resources tend to be 
more specialized. One doesn’t need to keep book of all equipment pieces that are going to be used 
in the project, however, it is recommended to configure the equipment sources when:  

• Many teams or persons need simultaneously an equipment piece for performing 
different tasks and the equipment could be reserved in many more places than it can afford.  

• There is a desire for organizing and recording the costs related to the equipment. 
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The budget or the cost stands for one of the project triangle model’s components. Almost 
all projects have a certain financial aspect and the costs control numerous projects’ objectives. The 
purpose for assigning a standard paying rate (Std. Rate) for a material resource is that of estimating 
as correct as possible the materials’ costs compared with the project’s plan (and subsequently 
keeping track of them). Not all resources are paid at a direct standard rate. For some resources, one 
needs to pay overtime (Ovt. Rate), due to the fact that it works more than an estimated number of 
hours for an estimated time period. The cost doesn’t increase in the same way for all resources. For 
example, when renting an equipment, it might be necessary to pay a rental fee, yet the employees 
tend usually to rise the price once the time goes away. Within Accrue At, one specifies the way 
how Project should deal with a resource’s cost increase (for instance, if the rental fees must be 
paid until using the equipment, one fixes Start in the Accrue At field). 

 
Resources’ assignment to tasks 
An allocation or an assignment stands for an association between a resource and a task in 

order to perform operations. Speaking from the tasks’ perspective, this could be known as a task 
assignment, whereas from the resources’ perspective, it could be called resource assignment. A 
task plus a resource represent an assignment. One doesn’t need to assign resources to tasks within 
Project; he/she could operate only with task. If resources are allocated to tasks, then the following 
questions could be answered:  

�Who should work, perform what tasks and when? 
� Is there a corresponding number of resources for accomplishing the work quantity 

requested by the project? 
� Is there the possibility that a resource work at a task in a period of time when that 

particular resource is unavailable for work (for example, when will the resource be absent)? 
�Was there a resource allocated to so many tasks that the resource’s work capacity 

exceeded – in other words, the resource become overallocated? 
� Could one evaluate the resource’s performances while comparing to a pre-established 

plan? A resource which seemes to be very busy and need double amount of time for performing a 
task, compared to other resource, may not be as productive as it appears.   

 
Assigning a resource to a task allows an evaluation of the resource’s progress while 

working with that particular task. If information regarding costs is introduced, Project also 
calculates the costs for the resource and activity.  A resource’s work capacity is measured by units 
and is recorded within the Max.Units field. Except the case when it’s not mentioned, Project 
assigns 100% of resource’s units to the task. If the resource has less than 100% of the units’ 
maximal number available, Project assigns the maximal value of the resource’s units.  
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Project calculates work, using the so called sometimes sheduled formula method:  
Duration x Units = Work 

The Task 8 lasts for one week. For the existing project, one week covers 40 hours (one 
could find out how many hours a week is made of, by opening the Tools menu, choose the Options 
command and click on the Calendar etiquette). 

 
Within the Gantt Chart view, one clicks on the 3rd activity’s name – “Schedule finalization 

and estimations of owner and architect”; then choose the Slip option from the Windows menu. On 
the screen appears the Task Form box, within the bottom panel of the Project window. Task Entry 
displays the Gantt Chart view in the Project window’s upper panel and the Task Form view in the 
panel below. Task Form simultaneously displays all three variables from the scheduled formula: 
task’s duration in the Duration field, resource’s units within the Units column and the resulted 
work value for attaching to task in the Work column.  
 

 
If one adds resources to tasks after an initial assignment, the total amount of work hours 

remains the same, yet, it is distributed between the assigned resources. The task’s duration 
decreases correspondingly, the validation sign (implicit) within the Effort Driven validation box 
shows the fact that the effort driven schedule is activated for the task 3. It is not compulsory the 
effort driven schedule to be applied to all project’s task; when needed, one may deactivate  it (in 
this case, the task’s duration remains the same, no matter how much resources are assigned).  

 
Conclusions  

 
Microsoft Office Project 2007 gives you robust project management tools with the right 

blend of usability, power, and flexibility, so you can manage projects more efficiently and 
effectively. You can stay informed and control project work, schedules, and finances; keep project 
teams aligned; and be more productive through integration with familiar Microsoft Office system 
programs, powerful reporting, guided planning, and flexible tools. 

Project 2007 integrates smoothly with other Microsoft Office system programs. Build 
projects with a few keystrokes by converting existing task lists in Microsoft Office Excel and 
Microsoft Office Outlook into project plans. With Project 2007, you can easily assign resources to 
tasks and adjust their assignments to resolve conflicts over allocations. Control finances by 
assigning budgets to projects and programs. Improve your cost estimates with Cost Resources.  
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